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[bookmark: _Toc535252007][bookmark: _Toc535252399]1. Goals: Efficient Use and Citation of the Biochemical Literature
PubMed, the database most useful for biochemistry, adds about 700,000 articles per year. The literature for even a small field can be overwhelming, and winnowing out the papers that are most relevant to a topic is a challenge. Furthermore, during this process one would like to get a sense of the community’s view of the significance of the papers that are found. Then one needs to be able to cite papers and other sources properly and efficiently in one’s own work. The goal of this session is to show you the most commonly used approaches to these problems. This is not comprehensive, as there is abundant documentation for PubMed, Web of Science, EndNote, etc.; rather, it is focused on techniques I have found most useful.
Note that many of the programs and web sites discussed here are frequently updated. Some of the specific techniques in this document will go out of date, but the ideas should be useful indefinitely.
[bookmark: _Toc535252008][bookmark: _Toc535252400]2. Database Resources
[bookmark: OLE_LINK7]There are many ways in to the literature. PubMed is the primary source for most of us, typically accessed with a web browser. It has excellent coverage of biochemistry, molecular biology, and medicine. It is less useful for bioorganic chemistry because some of the premier chemistry journals were added to the index relatively recently, and it cannot search for structures. For these purposes, use SciFinder Scholar, provided through the American Chemical Society (download and install client software as directed don the Chemistry Library blog, http://www.lib.umd.edu/blogs/chemistry/, or use the web version, as described below). For physics/biophysics, both can be used. The ISI Web of Science is useful for author searches and for citation patterns, for identification of highly cited works/people, and for finding out how a particular paper was followed up. Google Scholar in my experience gives results similar to PubMed, but it may access full-text versions in odd places and may find textual references that the more keyword-oriented PubMed misses. Google is likely to improve over time more rapidly than other sources. Many journals have links to find citing papers using Google or ISI. Finally, some centers, individual scientists, and companies have very good web sites, especially in systems biology or other areas where there a lot of supplementary data is provided.
[bookmark: OLE_LINK2][bookmark: OLE_LINK11][bookmark: OLE_LINK3][bookmark: OLE_LINK12]The University of Maryland provides access to many databases through the catalog home page at http://www.lib.umd.edu/index.html (click ResearchPort), and the Chemistry library web site is also a good jumping off point, at http://www.lib.umd.edu/CHEM/.
[bookmark: _Toc535252009][bookmark: _Toc535252401]3. Basics of PubMed
[bookmark: OLE_LINK4]http://www.ncbi.nlm.nih.gov/ is the main NCBI site. PubMed is at http://www.ncbi.nlm.nih.gov/pubmed/
[bookmark: OLE_LINK13]Typically we search by subject or author or both. Often you can just enter key words naturally: try “Widom chromatin.” You can give author initials: “Kahn JD,” and if you need to restrict to an author, use e.g. “Burns [au]” or ‘ “Rokita SE”[author],’ with the double quotes forcing a phrase. The help pages describe many other search options, and you can combine searches (it’s a Boolean syntax, so “#2 AND #3” gives the intersection of the two sets, not the union); look under the History tab.
Here is a table of some of the codes used to restrict a search:
	Restrict to:
	

	Author
	[author] or [au]

	Year of publication
	[publication date] or [dp]

	Range of year of publication
	 YYYY[dp]:YYYY[dp]

	Journal
	[journal] or [ta]


[bookmark: OLE_LINK14]Remember if you want to search for an author and you want to use their initials, you would type: Burns JE. Don’t use a comma between the last name and the initials. 
PubMed will return a list of papers. The Display menu at the top of the list has several options, with the Summary view being the default for an initial search. The papers found look like the results below (from http://www.ncbi.nlm.nih.gov/books/NBK3827/).
[image: summaryanatomy]There are tabs at the top right for “All:” and “Review:.” If you want one of them click the full-text link. To go to the Abstract view of an article, click the title. From the resulting entry for a single paper, if you want all the papers by one of the listed authors, click his/her name. If PubMed knows where the full text of the article is available, it displays an icon linking to the source at the top right.
The other useful Display choice is “Abstract,” available from the arrow next to Display Settings. The “Abstract” format shows abstracts, download links, and “related citations” links for all the papers found in the search. To obtain a plain text file sort of suitable for import into EndNote or other reference managers (see below), click the arrow by “Send To,” choose the “File” radio button, and then select the “MEDLINE” format. A plain text file will be downloaded to your computer for subsequent import into EndNote using the “PubMed(NLM)” filter in EndNote. [This is not necessarily the best way to import, though.]
The “Related Citations” link near each reference is especially useful. It brings up a list of papers related to the one you are looking at. According to PubMed Help, “PubMed creates this set by comparing words from the title, abstract, and MeSH terms using a word-weighted algorithm.” You can sort this list by date to keep up with current developments relating to a starting paper. 
PubMed is extensively linked into the rest of the NCBI databases and the Protein Data Bank (PDB). Almost any journal worth reading in a bio-related field is abstracted in PubMed, although coverage of some chemistry journals is not as good, especially for older papers.
[bookmark: _Toc535252010][bookmark: _Toc535252402]4. Basics of Web of Science
[bookmark: OLE_LINK1]http://www.isiknowledge.com/, from an on-campus IP address or through a VPN, although the latter may not work. Also see http://www.isiwebofknowledge.com/.
ISI (now Thomson Reuters) is a company that tracks citation patterns and statistics. The Web of Science is meant for tracking citations of papers and identifying highly-cited papers and individuals. It is the basis for the derivation of journal impact factors, which (fortunately or unfortunately) are given a lot of weight in things like grant and tenure decisions. For day to day use, the Web of Science is another way to find related articles and follow-up work. When exploring a new area, it’s a good way of finding out whether anyone else has ever cared about the neat paper you found from 1982, for what that’s worth.
[image: screen-capture-1]I find the Cited Reference Search to be the most useful. The easiest way to use it is by author name; in going for a particular paper, use an obscure author to reduce the number of hits. You can choose one paper and then click “Times Cited” to bring up a list of papers that cite it. You can also choose several papers and then click “Finish Search” to find all the papers that cite any of the chosen papers. Either way, you get a list of articles that cited the work(s) in question. I search myself periodically to see what impact our work is having: early in your project, I recommend doing a citation search on your group’s work to see whether and how other people are following up on the work. 
[image: ]Thomson-Reuters is also the source of journal impact factor ratings and the “h-index,” which are objective, if flawed, methods of assessign the impact of a journal or a person. For example, you should look at the h-index of any prospective postdoctoral mentor as one element of your decision. Web of Science / Search /enter author name/click Create Citation Report.
[bookmark: OLE_LINK15][bookmark: OLE_LINK6]
[image: ]Below the title of the record for an individual paper, there is a button labeled “find it.” Clicking it will bring up a window with links to the electronic full source or the location in UM libraries. If it is unavailable on line or on campus, it can take you to an Interlibrary Loan (ILL) request. This is the easiest way I have found to generate an ILL request (otherwise go through Research Port at http://www.lib.umd.eduor to http://www.lib.umd.edu/ILL/Welcome.html). You will need your bar code from your ID to place an ILL request. Typically the ILL staff finds the article at a participating library, scans it to a PDF, and sends you an email with a link to the PDF.
Our access to the literature has become much less comprehensive than it once was, and unfortunately it is not at all unusual to come upon the dreaded screen asking you to pay $35 for a PDF, so you may find yourself resorting to ILL more frequently than you would like. In cases when you want a relatively recent paper, I find it is often more efficient to just ask the author for a PDF (within reason of course). The quality is often better than the scan that you otherwise usually receive.
[bookmark: OLE_LINK16][image: screen-capture-2]There is also a button for exporting citation information to EndNote or other bibliography management programs (see below). Use the ISI-CE filter to import the resulting file if your version of EndNote does not recognize the downloaded file automagically. “Endnote Web” gives you a database at ISI, apparently for free, for now (http://wokinfo.com/products_tools/bibliographic/enw/). I have not tried this. There is information on it at http://lib.guides.umd.edu/chemistryresources. ISI owns EndNote, so the integration between the ISI web site and the program is improving.
To explore connections among papers or discover the ur-sources for an area, there are graphical versions of citation maps available at Web of Science. These interactive maps are fun, but not as useful as they might be in identifying the critical papers, because it does not seem possible to filter by times cited or to locate older papers that are cited in several of the test papers’ references.
[image: screen-capture-2]Finally, Google Scholar (http://scholar.google.com) has emerged as a competitor or companion for all of the above databases. I have generally found it easy and intuitive to use, but the results to are less predictable and comprehensive than those available from ISI or PubMed. Scholar is free and it is likely to improve, and betting against the rate of improvement of Google is ill-advised. At worst, Scholar’s existence will drive innovation on the part of all the others. Sometimes, you can get a PDF through Scholar that would otherwise be unavailable, for example when an author has (usually illegally) posted a PDF of his/her work on a lab web site.
[bookmark: _Toc535252011][bookmark: _Toc535252403]5. Rudiments of SciFinder
[bookmark: OLE_LINK9][bookmark: OLE_LINK8]SciFinder has the ability to search by author and topic much like PubMed. The department has a limited number of concurrent licenses that should be used from machines with campus IP numbers or through ResearchPort. See http://www.lib.umd.edu/blogs/chemistry/ and search for SciFinder to find out how to set up an account to use the Web version, accessible at https://scifinder.cas.org/. SciFinder accesses the full Chemical Abstracts database, so it will find articles in the chemical literature that PubMed will not, but where SciFinder is really essential is in searching for chemical structures:
Searching for this…	brings up this…
	[image: screen-capture-2]
	[image: screen-capture-1]


If you need to know more about how to use SciFinder, consult your friends who do synthetic chemistry here or Svetla Baykoucheva (sbaykouc@umd.edu), who is the Chemistry Librarian and a real expert. There are other databases like Beilstein and Gmelin that are also of use for chemists. 
Remember that access to SciFinder is a shared resource: we have a limited number of seats, and if you are logged in without actually searching, you may be blocking someone else who actually wants to get something done.
6. Obtaining Articles
[bookmark: OLE_LINK51][bookmark: OLE_LINK52][bookmark: OLE_LINK18][bookmark: OLE_LINK10]Most articles that you find are available simply by clicking on a link: UM has excellent (although less excellent than it used to be) on-line access to journals. Elsevier journals are accessed through ScienceDirect. If you are doing literature work off-campus, for access to journal articles or Web of Science, you will probably have to log in to the UMD libraries’ ResearchPort. You will need your UID to log in to researchport.umd.edu. I find using ResearchPort extremely annoying, because you often can’t go directly from one journal to another and instead have to go through the port, and it seems to want you to log in every five minutes. Sometimes just pasting “.proxy-um.researchport.umd.edu” directly into the journal’s URL will work. ResearchPort is actually a useful way to collect links to your favorite journals that are accessible from anywhere. For some databases or other searches you may need to install a VPN (Virtual Private Network) client, which makes your home computer look like it has an on-campus IP number. (http://www.helpdesk.umd.edu/topics/applications/vpn/3836/). Don’t bother doing a lot of literature work from home unless you have broadband. 
Access methods change over time. For now, I generally search from a campus IP address when I can! I only search from computers with keyboards, not smart phones, watches, iPods, mood rings etc.
[image: ]
If the UM system does not have a subscription to the journal, you can request the article via ILL, as described above. The simplest way to do this is do locate the article on the Web of Science and click the FindIt link. My personal experience is that at least until recently I seldom needed to place these requests for general exploration of the literature. I use it to obtain relatively obscure papers that may be directly relevant to an experiment I’m doing. Basically, if the abstract on PubMed suggests that I really should reference a paper that we don’t have, I will get it through ILL to see whether it’s worthwhile work.
Some of the older literature is not available in digital form, and even if it is the available PDF’s may be low-quality scans (for example through the JSTOR archive at www.jstor.org). Many older PDF’s are not searchable and will not print well, because they are actually scanned images. In these cases, it may be necessary to corporeally appear at the White Library or even McKeldin or the Engineering Library and find the paper volume containing the work of interest. You can buy photocopy cards for the library from machines in the library or charge to a Terrapin Express account. 
If you need a book that the library does not have, talk to Svetla Baykoucheva, the director of the White Memorial Chemistry Library. She also knows a great deal more than I do about all of the database products available to us. 
[bookmark: _Toc535252012][bookmark: _Toc535252404]7. What Do You Do with the Link of Interest at the Journal’s Web Site?
You can almost always download a PDF version of the paper. I recommend configuring your web browser to use Adobe Reader as a helper application rather than using the Adobe plugin or the web browser’s own rendering engine. This will force the browser to download and save the paper rather than displaying it in an easily-lost window. To be most useful, the PDF must not only be downloaded but must be further analyzed by a process that Sydney Brenner called “neuroxing,” whereby a human operator scans his/her eyes across each line of text and attempts to interpret the pattern of letters and pictures (see http://www.independent.co.uk/arts-entertainment/under-the-microscope-heard-the-one-about-1293155.html). All too often we omit this step in our explorations of the literature. Dinosaurs like myself will often go so far as to print out a paper and then write notes all over it. You can summarize your opinions about the paper in the Notes field of its entry in your EndNote database if you like (see below), or perhaps record a discussion of the paper into your cell phone. More seriously:
It is intellectually dishonest to cite a paper that you have not at least skimmed. For example, copying references out of source paper without looking at the references yourself is unacceptable. You should be able to give a reason for the inclusion of any paper in your bibliography.
Depending on the journal, electronic versions of the paper besides the PDF may be available and/or useful as well. The HTML version is best for jumping around among references and figures, for rapidly following chains of citations, and for copying individual figures. The HTML version is not meant to be printed out. Usually better resolution for the figures is available from the PDF; I have found that zooming in with Adobe Reader and then copying the graphic gives the best results. Some papers are copy-protected, in which case you can just do a screen shot. Sometimes you can download PowerPoint slides of individual figures. Many journals have “download to citation manager” links. Clicking on this may or may not load the reference directly into EndNote. If not, it will create a file on the desktop, named something like “citmgr_endnote.” This is imported as an “EndNote Import” as described below. Other resources that the journals may provide include lists of papers citing the article you are reading, the Citation Map discussed above, and links to Google Scholar, PubMed, and ISI. 
Examples:
Many useful links are over on the right side. Science Direct/Elsevier makes them a lot less useful than they could be, because as a for-profit publisher they try to keep you in their sphere.
[image: screen-capture-4][image: screen-capture-3]


ACS journals have related but different external links of this nature (they do allow citation management). Note that SciFinder is an ACS product. 

[bookmark: _Toc535252013][bookmark: _Toc535252405]
8. What is EndNote and How Do You Get References into It?
EndNote (http://www.endnote.com) is a combination database, retrieval engine, word processor plugin, and now PDF repository. It is designed to download and organize references and to automate the formatting of in-text citations and the creation of bibliographies. It has many other features, like manuscript templates, that I find less useful. Many scientists have a love-hate relationship with EndNote, but writing a scientific document of any length without it or a competing product is foolish. There is a new version every year, but improvements are often only incremental (X4 seems to be quite substantive, however). I upgrade only when a must-have OS or Microsoft Office upgrade breaks EndNote, which usually happens. This document has pictures of EndNote X for Mac. EndNote X4, the next-to-newest version, will be used in class. Fundamentally they all work similarly. 
There are four steps to using EndNote. First, you import references into a library. Second, you write a manuscript and insert temporary citations to references in the library. Third, you format the bibliography (this can be done many times, and can even be done as you write, if you like to live dangerously). Fourth, you look at the results carefully and iterate back to steps 1, 2, and 3 as needed.
EndNote is a database, and that means it is finicky about data entry and formatting. Errors will propagate into your bibliographies aggressively. There are four ways to get references into EndNote.
a.	Type. Almost never necessary, but you should do it once or twice for practice so you understand the database fields. The most common mistakes are with author names and journal abbreviations. You must make sure that each author appears on a separate line in the Author field, and you must have a consistent algorithm for journal names or abbreviations (see below).
b.	Import from PubMed, Web of Science or other search engine output files. (see pictures below.) Choose File>Import or customize your interface to add an Import button. The tricky part is picking the correct import filter using the “Import Options” drop-down menu as shown below. You can import Medline-formatted text files or the files generated from clicking on “Download to Citation Manager” links. Unfortunately, figuring out which combination of filters to use is largely trial and error, but once you have a system in place EndNote can remember your chosen filters. Use the PubMed(NLM) import filter for Medline-formatted text files, ISE-CE for Web of Science.
c.	Import from the journal web page directly. ISI and some journals allow you to download native EndNote files. Windows may be able to open them directly, for Mac one must usually import as above. Use the “EndNote Import” filter for files named “citemgr#”. For files named “science-#” use RIS format (usually these are downloaded from Elsevier journals).
[image: ]
d.	For EndNote X4 or later, you can just drag PDFs to the EndNote icon. This sounds ideal, but you end up with a copy of the PDF buried in the EndNote database, which rapidly blows up in size. It doesn’t work for older PDFs, it doesn’t always work for newer PDFs, and the abstract is not imported into the abstract field. In X5, EndNote has a built-in PDF viewer, probably because this feature came out in a new product called Papers that has a much nicer interface. When iPads or other tablets come into wider use, the ability to annotate directly on the PDF may change how we interact with papers; for now I like to be able to copy individual PDFs from place to place.
e.	Recommended: Direct connection within EndNote to PubMed or other databases. This brings up a “Find” window just like the one used for searching within your own EndNote database that happens to be connected to PubMed (or whatever database you chose). Especially for large-scale importing, this is generally the best option. It usually gives clean results, it allows some exploration, and allows you to examine references easily before selecting them. Unfortunately, the Connection utility does seem to crash EndNote with some regularity. Access it with Tools>Connect or use the menu bar. In X2, the original version automatically loads all the references into your library, but subsequent versions can go back to the older and better method of having the references appear in a temporary space and then allowing the user to copy only chosen references into the local library.
[image: ]

The most important thing you cannot do is generate EndNote records from a formatted bibliography! Parsing a bibliography is actually quite difficult, so they don’t try.

Managing EndNote databases:

I recommend maintaining one large EndNote database for yourself rather than fussing with individual databases for each paper. That way, if you go back to an old MS you will probably still be able to work with it. I never use traveling databases or EndNote Web.

If you are collaborating with other people on a manuscript, EndNote can format their citations in the MS, but it is risky. I recommend assigning one person to be the reference editor and allowing only that one person to mess with formatting the bibliography. I never mess with traveling libraries, because everyone ends up with duplicate citations that can confuse other manuscripts.

Sharing your master EndNote database with a colleague is kind of like sharing a toothbrush. Only one person should mess with your EndNote database.

Keep careful backups of your EndNote library as well as the accompanying data folder (one is probably a .enl file, the other is a .Data folder). If you move the library from computer to computer, keep the data file with it. Annoyingly, their modification dates do not seem to change so if you are used to synchronizing by searching for today’s files it will not work. X4 and later offer the option of maintaining everything together as one package, highly recommended.

Here is a typical EndNote library panel and reference:

[image: Picture 5]
[bookmark: _Toc535252014][bookmark: _Toc535252406]
Maintaining an EndNote database takes work, but it’s worth it. You should look at each import before finalizing. The three most common problems with making bibliographies are that (a) the author names are screwed up, (b) journal names/abbreviations are inconsistent, and (c) capitalization is incorrect (c.f. “mrna” or “drosophila”), (d) Greek letters, accents, subscripts and superscripts, italics, and other symbols are lost from imported titles. Problem (a) is solved by making sure each author is on a separate line and is formatted “last_name, first_name middle_initial”. Problem (b) is solved using the Journal Term List (Tools>Open TermLists>Journal term List). For every journal that you use, enter the journal name as abbreviated by PubMed into the Abbreviation 3 field. Then put your preferred abbreviation for the bibliography into the Abbreviation 1 field and a quick mnemonic (e.g. PNAS, JMB) into the Abbreviation 2 field (see below). The goal is to make sure that EndNote recognizes each journal when it’s time to format the bibliography. You will also have to edit the Output Style to set the “Journal Names” setting to Abbreviation 1. Check your work with the Preview panel. Problem (c) is solved with the Change Case tab in the Preferences, which tells EndNote not to mess with capitalization on the entered technical terms. You can share Change Case files and journal term lists. Problem (d) is especially important when you actually cite a paper in a formal bibliography. Use the Edit>Font menu for bold. subscript, etc, and the Character Palette to insert symbols (Mac OSX). This is inconvenient but it should obviate problems with different systems using different font glyphs.

Here is the journals term list. If the PubMed abbreviation is listed as Abbreviation 3 it will be recognized when you import a new paper, and then the formatted citation can be properly abbreviated as in Abbreviation 1. 
[image: ]
You can use EndNote to organize paper and electronic documents. I recommend including abstracts in the library but not linked PDF’s: the size will blow up. Newer versions of EndNote allow you to create a link to a PDF that is resident on your disk without copying the entire file, which allows you to move the database on a flash drive around without dragging hundreds of papers with it.  I rename downloaded files in a consistent way (e.g. journal_year_vol_pages_comment.pdf) and then add the file name to the Keyword field in the EndNote record. I file paper papers into folders named according to the EndNote Label field. You can even define an EndNote output style (downloadable from my web page) that will automatically generate a possibly useful file name. This all takes time, but how much aggravation might it save relative to searching for a paper for 20 minutes, 30 minutes before a deadline? See http://www.biochem.umd.edu/biochem/kahn/teach_res/Biochem677/Biochemlit.html.
9. Creating In-text Citations and a Bibliography
EndNote acts as a plugin or add-in within Microsoft Word. It can also format RTF documents. They claim that it works in Pages but it is too buggy to actually use. Most of the menu items are listed under Tools or an the EndNote menu bar. You will find EndNote versions 2-9 and Xn on computers on campus. Unfortunately, the details of how to do everything are slightly different for each combination of Office and EndNote. The outline here should work for EndNote ≥ X4, and the idea behind each step has not changed. Most EndNote versions work on only one or a small set of Word versions. I recommend that you invest in a recent version of EndNote. The abbreviated directions below assume that you are not using Cite While You Write. CWYW is slow and buggy, intended only for people who don’t understand how EndNote works and need to see insta-formatting. EndNote can frequently crash itself or Word: save often! EndNote is picky about where its Style and Connection folders are kept.
As you type, Insert Citations. You can find them by sorting the library in various ways or by using its built-in find function. Make sure you use citation delimiters that are otherwise rare in your document; the default brackets are usually not good for chemists because the delimiter appears in [NaCl] or CCl2[CH3]2 change the default delimiters (brackets []) in Preferences/Temporary Citations to something like braces, which I am not putting here because EndNote insists on trying to format them and then crashes itself and Word when I hit cancel. You can insert multiple citations. You can enter citations by hand but I don’t advise it. Watch out for consistent formatting of multiple in-text citations, especially if you are using a numbered in-text citation style. If EndNote cannot figure out what citation you mean, it will ask you when you format the bibliography.
At any point, you can Format the Bibliography, which formats in-text citations and generates a bibliography according to the directions in the Journal Style that you choose. The first time you do this, it will prompt for which style and library to use. It will put the bibliography at the end, but if you move the bibliography it will subsequently be reformatted properly in situ. If you submit to a different journal, all you have to do is pick a different Style! You should always use the same library, which is among your most precious files to be maintained and backed up. If you are batting a paper back and forth among authors, try to have only one author mess with the citations. Don’t even think of editing citations when going back and forth between Mac and Windows, even though the documentation says you can. 
Edit the Style if necessary, using the Output Style manager. You can download thousands of styles from the endnote web site, but most of them are actually not very good. The style almost always requires some tweaking, especially when choosing the proper journal abbreviation (specifically, define an abbreviation to use with >Edit>Output Styles>[Edit desired style]>Journal Names. The style syntax is quite arcane, so be very careful and read the documentation. Check the results using the preview panel. If you have trouble with the output, it is often useful to Unformat Citations to see whether they have been altered in some unfortunate way. This often happens if you have accidentally deleted a delimiter or something like that, or you have changed a multiple citation without being careful.
When you’re ready to send the MS to the publisher, Remove Field Codes to convert the citations and bibliography to plain editable text. This generates a copy of the document that cannot be worked on with using EndNote any more. Make as few changes as possible thereafter! Before you send out the document, do a search for the citation delimiters to make sure that all the citations were found. I have often reviewed MS’s with things like “{Jones, 1977, #1987” in them, and no citation to Jones in the bibliography. 
Be very careful altering the citations or bibliography by hand. You can add notes that will appear in the formatted citation using the syntax in the table below (from Mac EndNote 8 help docs), but never alter formatted citations by hand, because the changes will be lost the next time you format the bibliography. If there are problems with the bibliography, fix them by changing the style or the EndNote record, not by hand! Again, any changes you make in the bibliography by hand will be lost the next time you format.
I do not recommend trying to include references in text boxes or figure legends. The reference numbering will be screwed up. If you must have a reference in a legend or table, make sure you have previously referred to the paper in the text.
Remember, the most common and most unprofessional EndNote errors are inconsistent journal names or abbreviations and incorrect capitalization.
EndNote is one of those programs that saves a tremendous amount of time and effort, except when it doesn’t. Expect to struggle for a while to get a perfect bibliography.
Competitors include RefWorks and BookEnds, as well as Zotero and Papers. Papers seems to be emerging as the most important alternative.
Remember, try to convince EndNote to do what you want automatically rather than changing things by hand: that way, you don’t have to re-do the changes every time you edit the MS. The table below shows how to change the in-text citations as desired.
[image: Picture 8]

10. The Papers Alternative.
Papers (www.mekentosj.com) has emerged as a viable competitor to EndNote. Papers is really meant to organize PDF’s, EndNote is really meant as a database. Papers is simpler, cheaper, more elegant, and crashes less. On the other hand, it is less configurable, it does not have the same level of integration with web resources and search engines, and EndNote libraries can be much larger and can be more easily shared. As with EndNote, Papers is a combined search engine, PDF archiver/viewer, database, and bibliography generator. It is available for Mac, Windows, and iOS.
Typical workflow: Download a PDF. Drag it to Papers. Papers will “Match” it at Pubmed automagically, and you will end up with a database entry that includes the PDF and possibly the HTML version of the paper or the web page, useful for chasing links. There is a browser built in to the viewing window, but I do not recommend following a long chain of links, since it can lead to unexpected downloads or confused records. You can also search for papers within Papers using its built-in natural language searching, somewhat more easily than in EndNote.
[bookmark: _GoBack]To enter citations in a manuscript, copy one or more entries from the list of papers in Papers, and paste into Word where you want a citation. [Set the Preference to Drag Papers as a Magic Citation.] You will see a pasted entry composed of braces around the “citekey,” which is an identifier generated within Papers that should be unique. The pasted entry looks like {Author:yyyyzz} where yyyy = publication year and zz (or zzz) is a two (or three) letter code. To format the MS, press Control-Control to pop up a floating dialog box that lets you do many things, including creating a bibliography.1 You can also search within the little pop-up dialog to insert citations.2 This paragraph includes autogenerated citations, and the bibliography is below. 3-5. 
To submit the MS you will want to remove all the field codes: see the built-in help for directions on how to do this. 
Cautions: I have found that cooperating on editing an MS with Papers citations is problematic, and it is essentially impossible to share libraries. If Papers sees a new citekey it will offer to find the references that are not in your database, but this frequently leads to references that fail to format. Also, it is hard to set up variant abbreviations, and as far as I can tell it is nearly impossible to edit an output style. Papers syncs with iOS, and with careful setup you can maintain a library in Dropbox to allow use on multiple computers, but if both of them are running Papers at the same time, disaster is likely. Papers has a free trial period, but to use it thereafter you really need to purchase your own copy.
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1.	Haeusler, A. R. et al. FRET studies of a landscape of Lac repressor-mediated DNA loops. Nucleic Acids Res. 40, 4432–4445 (2012).
2.	Wilson, C. J., Zhan, H., Swint-Kruse, L. & Matthews, K. S. Ligand interactions with lactose repressor protein and the repressor-operator complex: the effects of ionization and oligomerization on binding. Biophys. Chem. 126, 94–105 (2007).
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You can annotate the paper: select text and control-click or just control-click anywhere, for a menu including “Make a Note.” You can also save a page of general notes, and there is a social networking option, “Livfe” for reading and providing reviews, which I have not found useful. You can export an annotated PDF.
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11. Literature Assignment: Due Friday, January 11, 2011, 11:59 p.m.
Choose one of the labs in the Department of Chemistry and Biochemistry, possibly the one you are joining. Pick a research area of current interest in that lab. Do a brief literature search on the area and identify at least 15 key peer-reviewed references (i.e. no web sites), of which no more than 5 can have the PI as an author. Write a one-page summary of the area of research and include in-text citations to the 15 papers you have identified. There must be some rhyme or reason to the citations. Create a bibliography including the 15 references. Use EndNote or Papers to create and format the citations and bibliography, and leave them in the text as field codes (i.e. do not Remove Field Codes). The in-text citations can be any format but must be consistent with each other. The bibliography can be any format, but must meet the following conditions:
a.	References must include complete titles and inclusive page numbers.
b.	Formatting of volume and issue numbers, author names, etc. must be consistent.
c.	The names and abbreviations of journals must be consistent, and you must abbreviate long names. I figure out which abbreviations to use by referring to other papers in the target journal, or the ACS has a style guide (reference shelves in the library, QD8.5.A25 2006).
d.	Author lists with fewer than ten authors should not be truncated with “et al.”
e.	Capitalization of all terms should be correct.
f. 	Bibliography style must be consistent with citation style. In other words, numbered citations should match numbered references, (author, date) citations should have corresponding bibliography entries.

Warning and Exhortation: This assignment may seem like busy-work, but in my experience >30% (!) of the references in the typical dissertation bibliography have typographical errors, often sufficiently serious errors so that the reference cannot be identified. You must examine your bibliography carefully. EndNote and Papers are just tools. They are not magic. Bibliography generation exemplifies the classic phrase “Garbage In, Garbage Out.” Sloppy bibliographies are unprofessional, and they can delay the publication and review process. They break a cardinal rule for publishing and grantspersonship, which is “Never annoy the reader unnecessarily!” Finally, this is a writing assignment, and therefore my strictures on plagiarism apply (www.biochem.umd.edu/biochem/kahn/plagiarism.html): this must be your own work!

Due Date: Friday, January 11, 2013, by 11:59 p.m. Please email me (jdkahn@umd.edu) your Microsoft Word document. Your name should be on the top line of the actual document and it should also be part of the file name (example: document name = Joe_Smith_bchm677_2013.doc, first line of the document = BCHM677: Joe Smith).

Example:
BCHM677 sample: Jason Kahn
Widom’s studies of the cleavage of nucleosomal DNA by restriction endonucleases1 showed that the DNA was far more accessible than previously expected, and that it became progressively more accessible near the ends of the occupied region. Further work using templates that could have supported either sliding or unwrapping led to a proposal that chromatin remodeling by SWI/SNF-class ATPases proceeds through trapping of transiently unwound DNA2.
1.	Polach, K. J. & Widom, J. (1995). Mechanism of protein access to specific DNA sequences in chromatin: a dynamic equilibrium model for gene regulation. J. Mol. Biol. 254, 130-49.
2.	Anderson, J. D., Thästrom, A. & Widom, J. (2002). Spontaneous access of proteins to buried nucleosomal DNA target sites occurs via a mechanism that is distinct from nucleosome translocation. Mol. Cell. Biol. 22, 7147-57.


(Annoyingly, Endnote does not let you delete the trailing paragraph breaks until you have removed field codes. This can force you to print an extra page if you are not careful.)
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“The following examples demonstrate how different modifications to a temporary citation affectts formatted citation in
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ABSTRACT

The Escherichia coll lactose (ac) operon encodos
the first genetic switch to be discovered, and lac
remains a paradigm for studying negative and
positive_control of gene exprossion. Negative
control is believed to involve competition of ANA
polymerase and Lac_repressor for_overlapping
binding sites. Contributions to the local Lac reprs-
Sor concentration come from froe roprossor and ro-
prossor delivered 1o the operator from remote
auxilary operators by DNA looping. Long-standing
questions persist concerning the actua role of DNA
Iooping in the mechanism of promoter repression.
Hore, we use experiments in ling bacteria to
Fesolve four of these quostions. We show that the
distance dependence of repression enhancement is
comparable for upstream and downstream ausiliary
operators, confirming the hypothesis that repressor
concentration increaso is the principal mochanism
of ropression loops. We find that as fow as four

presence of allolactose or ts snalog, sopropyl [ro-1-
thioglsctopyranoside (IPTG), reieving represion. In the
abience of glucose, RNA polymersse binds cooperatvely
wilh catabolite activator protina the ae promote (positive
control. In simplst terms, the mechanism of negatve
Control involves Lac repressor binding (o occluce access
of RNA polymerase holoenzyme 1o the fac promoler ().

Of particular signiicance (0 the present work i the
fascinating observation that two remole awxlary oper-
alors (O exist i the lac operon (). It has been
proposed and demonstrated (6-13) that bidentate repres-
sor tetamers bound at auiiary operators increase the
effective repressor _concentration at the  regulatory
operator (0) through DNA. looping (Figure 1), This
‘concept has been exploted as an approach 1o probe the
physical propertes of bacterial DNA in viro (14) and
within the bacteral nucleoid in viv (12,15-17),

“The natural auxiiary operalors of the ac operon have
iffrent alfiites s occur S hat one e ust upsrcars
and one i ar downstream of the regulatory operator im-
meditely provinal to the promoter. We have designed
experiments in living bactera o clrily the role of DNA
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Of partculsr significance 1o the preseat work s the
fascinating observation that two remote auxiliary oper-
ators (0,,) exist in the lac operon (5). It has been
proposed and demonstrated (6-13) that bidentate repres-
Sor tetramers bound at awxiliary operators increase the
effective repressor concentration at the  regulatory
operator (0) through DNA looping (Figure 1). This
concept has been exploited as an approach to probe the
physical properties of bacterial DNA in vitro (14) and
within the bacterial nucleoid in vivo (12,15-17).

‘The natural auxiliary operators of the lac ope G ' page 10

different affnities and. accur such that one is just upstream
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mediately proxi

experiments in living bacteria to clarify the role of DNA
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proximal operator is necessary and sufficient to explain

identical auxiliary operators positioned equivalent dis-
tances either upstream or downstream of the regulatory
operator should provide comparable enhancement of
repression by equally increasing the effective local repres-
sor concentration at the regulatory operator. Artificial lac
operators have been shown to enhance repression when
upstream or downstream of the promoter (18), but the
equivalence of upstream and downstream auxiliary
‘operators has not been previously tested in systematic ex-
periments. Second, we determined the smallest possible
DNA loop involving Lac repressor in living bacteria.
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